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If you read Matt Kloskowski’s Editor’s Note last month, you’ll know that he has passed the reins of editor-in-chief on
to me. In this first note, I wanted to say hello, and let you know how excited I am about the opportunity to run this great
newsletter. Over the past few months, I have been working with Matt, Annie, Dave and many of the writers to make
sure that we continue to provide you with the best tutorials, tips, tricks and advice for Adobe Photoshop Elements.
Matt especially has been an inspiration, and although he has set the bar pretty high for me, it is a challenge I relish.
We’re not planning any big changes to the newsletter, although I welcome any comments you might have about the things
you like best (or least) about it. We do plan to update the Web site so that it’s easier for you to find what you need among the
more than 400 tutorials, videos, tips and tricks posted on the site. That’s a big project, one that we’ll be working on through the
end of this year, and I’m looking forward to getting started on it.
And, while I know that Matt has mentioned this in the past, I thought I would toss out another plug for our Elements Village
forums, which you can find at www.photoshopelementsuser.com/forum. I am regularly amazed at the depth of knowledge and
creativity shown by the members there, as well as their helpfulness and patience when dealing with newcomers looking for a bit
of Elements guidance. It’s one of the best communities I’ve encountered in my years on the Web, and I strongly urge you to visit
it regularly, become a member, and ask questions when you’re looking for help.
Until next time,

rick@photoshopelementsuser.com
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15 SIMPLY DIGITAL PHOTOGRAPHY: capturing the magic of light

Mastering the qualities of light can make us better photographers. To that end, Laurie Excell offers us an
inspirational look at some different types of light.

30 SCRAPBOOKERS’ WORKSHOP: Tag, you’re it!

Tags are among the most versatile elements you can use on a scrapbook page, and they can say a lot
without resorting to overbearing sentiment. Nancy Marti shows us a few examples of her favorite tags.

It continues online, where you get exclusive access to print and video tutorials, discussion
forums, downloads, and a personal user gallery. It’s all part of the value-added benefits of
being an Adobe Photoshop Elements Techniques newsletter and Web site subscriber. And don't
forget to look in the Extras section online for free downloads and sample photos for many of
the stories in each issue at www.photoshopelementsuser.com/subscriber/printextras.php.
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Your learning doesn’t stop here!
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Digital Darkroom
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Step by Step

K L O S K O W S K I

hdr made easy
THE HDR CRAZE HAS LATELY CREATED QUITE A BUZZ IN THE PHOTOGRAPHIC COMMUNITY. I’LL SHOW YOU A WAY TO SIMULATE
THE EFFECT OF AN HDR PHOTO—WITHOUT ALL OF THE TIME AND EXTRA SOFTWARE IT USUALLY TAKES TO CREATE ONE.

If you’re unfamiliar with the topic, HDR stands for high dynamic range. It’s a unique, highly stylized look, and when done well,
it can really make a photo pop. Creating an HDR image involves taking several exposures of the same scene; usually three or five
bracketed images, captured using a tripod. The exposures range from very overexposed to underexposed and everything in between.
The individual images are then blended together on the computer to create one photo with an extremely wide range of intensity
levels in it. In a final HDR image, you can see all of the detail in the bright areas and in the dark areas, something impossible to
accomplish with a single exposure. Here, we’ll try to approximate the HDR look with a single photo.
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STEP ONE: First open the photo on which
you want to apply this technique. Photos
of cityscapes, cars, planes, statues, sunsets,
and other urban scenes usually make a
good candidate. Photos of people really
don’t work well: the HDR effect on skin
tones can be quite distracting.
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STEP TWO: One of the first things I’m
going to do is create a copy of the layer,
which will help us dial back the intensity
in case the final effect is too strong. Press
Ctrl-J (Mac: Command-J) to duplicate the
Background layer in the Layers palette
and create another copy of it on top. Then
click once on that new layer to target it for
the adjustments we’re about to do.

for more digital editing techniques, visit
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STEP THREE: Next, click on the Image
menu and choose Enhance>Adjust
Lighting>Shadows/Highlights. That opens
the Shadows/Highlights dialog box.
The first thing you want to do is take the
Lighten Shadows slider and crank it up to
100%. This brings out the details in all of
the shadowy areas. This should already
start creating some interesting effects on
your photo. (Don’t click OK, though; we’re
not done with this dialog box yet.)

Step FOUR: Take the Darken Highlights
setting and move it to the right until
things start to get little more “dramatic”
(65-75% often works well). This gets really
cool if you’re working on a photo with sky
in it, but either way, the bright areas of the
photo will now become darker.
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Step FIVE: Up until this point we’ve
changed a couple of settings that have
drastically reduced the contrast: it’s time
to get it back. Go down to the bottom
of the Shadows/Highlights dialog and
increase the Midtone Contrast slider.
Sometimes I drag this one all the way up
to 100%, but that may not work for all
photos. Something pretty high—between
70% and 80%—should do.
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Step SIX: Now we’re at the point where
you’ll have to start making some creative
decisions. The formula works pretty well
up to here, but you’ll need to decide if
your photo appears too dark or too light.
If it appears too light, then start tweaking the Lighten Shadows or Darken Highlight sliders. The Lighten Shadows slider
controls how much of the darker areas of
the photo we’ll see. The Darken Highlights
setting will make the whole photo darker
by toning down the bright areas. The more
you drag each slider to the right, the more
fantasy-like and surreal the photo will look.
This is where it gets to be a creative choice
on your part. With this photo, I’ll pull back
on the Darken Highlights slider just a bit.
When you’re done click OK and close
the dialog.
Step SEVEN: Now you’re back in the
main interface with your new photo
in front. If it looks like the effect is
too much, then just try decreasing the
Opacity slider for the top layer (the one
we created in Step 2) to show some
of the original photo below it. Here’s
a before and after of the photo we’ve
been working on.
Original

Final

6

In the end, it’s not exact, there’s very little
theory involved, and there’s no science
behind it. But you gotta admit, it just looks
cool and it sure beats buying another
program to get a similar effect. ■

Matt Kloskowski is Education and Curriculum Developer for the National Association of Photoshop Professionals. He has authored or co-authored several books
on Photoshop and Illustrator. His latest book is The Photoshop Elements 6 Book for Digital Photographers, co-authored with Scott Kelby, from New Riders Press.
Matt also teaches Adobe Photoshop Lightroom at www.lightroomkillertips.com.

©matt kloskowski
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The two photos on the right show another
before and after example of the same
settings applied to a totally different
photo. Cool huh?

©ISTOCKPHOTO/daniel halvorson

Step by Step

Wide World of Filters
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creating textured text in a mask
MOST FOLKS DON’T THINK ABOUT USING FILTERS IN CONJUNCTION WITH TEXT, BUT THEY ARE A great WAY TO “TEXTURIZE” YOUR PROSE. And WITH A LAYER MASK, YOU CAN CREATE BEAUTIFULLY DISTRESSED TEXT that remains editable.

STEP ONE: First, let’s prepare the text. Open
the image in which you would like to place
your “distressed” type (or create a new file).
Press T to grab the Type tool and create
some text. Be sure to pick a font with nice
fat letters, so there is maximum surface area
on which to run a filter.
Tip: To resize and move text while you’re
typing it, just press and hold the Ctrl key
(Mac: Command) and drag any resulting resizing handle. Hold the Shift key to
resize the text proportionately. If you want
to move the text around on the page, click
and drag from within the resizing box.

STEP TWO: Over in the Layers palette, create a selection of the text by holding down
the Ctrl key (Mac: Command) while clicking
on the type layer’s thumbnail (not the name
of the layer, but its thumbnail). Marching
ants should dutifully surround the text.
adobe photoshop elements techniques
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Step by Step

STEP THREE: Now, we’ll add a layer mask.
Press the half-black/half-white circle at
the top of the Layers palette to create
an adjustment layer. Choose Levels and
immediately dismiss the dialog by pressing
OK. By creating the text selection beforehand, we automatically created a mask.
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STEP FOUR: To have the filters applied
properly to our text, we’ll have to rearrange
and group the layers. First, drag the Levels
adjustment layer below the text.
Then, click once to select the type layer
and choose Layers > Group with Previous.
In the Layers palette, the type layer will
scoot slightly to the right and you’ll see a
downward pointing arrow appear to its
left. This is your clue that it’s now grouped
to the layer below.
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STEP FIVE: Now, we’re all set to run a filter…
or two or three. Click in the layer mask’s
thumbnail (it should have a tiny hairline
rule around it) and choose Filter > Distort
> Ocean Ripple. Enter 8 for Ripple Size and
4 for Ripple Magnitude. Press OK.
Run the same filter twice more (or as
many times as you’d like) by pressing Ctrl-F
(Mac: Command-F). If you want to run
a different filter, trot back up to the Filter
menu and choose something else. And, as
long as you run the filter on the layer mask,
the text remains editable.

for more on filters, visit
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Here’s the final result after placing the
text on top of a photo. For extra pizzazz, I
added a drop shadow to the text and used
the Cookie Cutter for a creative photo edge.

As the founder of the free tutorial site, GraphicReporter.com, and chief evangelist for iStockphoto.com, Lesa is on a mission to teach the world to create better graphics.
She’s the author of Photoshop: The Missing Manual (O’Reilly), Practical Photoshop Elements and From Photo to Graphic Art (KelbyTraining.com). Lesa writes for
NAPP, as well as Layers and Macworld magazines. Catch her Graphics Tip of the Week live each Wednesday on YourMacLifeShow.com.
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NOTES: You can also just apply a filter to a
text layer, but Elements will ask you if you
want to Simplify the layer, which will make
the text completely non-editable. To do
anything to the text at all, you will have to
retype it. However, by creating a selection of
the text and then placing it in a layer mask
you retain the capability to edit the text.
With this method you can easily change the
color of the font on the fly to see what looks
best: simply double-click the type layer to
select the text and click the color well in the
Options bar. Choose another color from the
Color Picker and press OK.
To do more than just change color
you’d need to go back a few steps but you
still wouldn’t have to retype the text. To
change the text font or point size, drag the
Levels adjustment layer to the Trash and
make your changes to the text. Start with
Step Two, load your new text as a selection, create another Levels adjustment
layer, and proceed from there.
Filters that work the best include
anything from the Artistic and Distort
sets, along with Sketch > Torn Edges. The
key, as usual, is to experiment. For a truly
enjoyable Friday evening, might I suggest
running through each and every filter
while enjoying a lovely beverage and
listening to your favorite CD?
Until next time, happy filtering! ■
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what you need to know
about shooting in raw
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All Images/Ben Long

IF YOU OWN A DIGITAL SLR CAMERa, “SHOOT RAW” IS ONE OF THOSE PHRASES THAT YOU HEAR ALL THE TIME, BUT
WHAT DO RAW FILES GIVE YOU THAT JPEG FILES CAN’T? THE ANSWER IS: “QUITE A BIT,” AND BEN LONG TELLS US WHY.

adobe photoshop elements techniques

With RAW images, you can often
recover detail in highlight areas
that have been overexposed.
If you look at the image on the
right, you can see how much detail
in the clouds has been recovered.
If it had been shot in JPEG format,
the detail would have been lost.
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f you’ve spent much time in the digital photography world—or recently bought a
digital SLR—you’ve probably heard about the RAW image format. While it’s not quite
the latest thing, it is still relatively new to most of us, and it’s still seen by many people
as something that only professionals use. However, with the strong RAW support
provided right in Photoshop Elements, there’s no reason for anyone with a RAW-capable camera not to give it a try. Whether it’s right for you depends largely on the types of
images you shoot and how much you like to edit, but it’s worth looking into.
What is RAW?
To understand what RAW is, and why you might want to use it, you need to understand a little bit about how your camera makes an image. While the lens, shutter,
aperture, and all of the physics of light are exactly the same in a digital camera as they
are in a film camera, there’s one major difference: instead of a piece of film sitting in
the back of the camera, there’s a digital image sensor.
An image sensor is composed of a piece of light-sensitive metal that’s divided into
a grid, with one cell representing a single pixel. When light strikes a pixel, the metal
there emits a number of electrons that is directly proportional to the amount of light
that hit. By reading the voltage at each pixel, the image sensor can build up a very
accurate grayscale image.

for more digital photography techniques, visit
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JPEG is a lossy image compression
format, which means you lose
image data every time you save
the file. Too much JPEG compression can result in an image with
annoying boxy artifacts.

adobe photoshop elements techniques

To get from this brightness-based grayscale image to full color, some tricky
computing is required. As you might already know, red, green, and blue light can
be combined to make every other color. When you mix red, green, and blue—
the primary colors of light—the resulting color gets brighter, until it ultimately
becomes white.
On your image sensor, there is either a red, green, or blue filter over each pixel.
With these filters, the sensor knows exactly how red some pixels are, how blue others
are, and how green the remaining pixels are. Using some very complicated mathematical operations, the image sensor can calculate the exact color of each pixel
by examining the values of the pixels around it. (Some cameras use filters other than
red, green, and blue, but the underlying theory is the same.)
If this sounds complicated, that’s because it is, and these interpolation algorithms
are closely guarded by the camera companies as trade secrets.
When you’re shooting in JPEG mode, the first thing the camera does after you
take a picture is to read all of the data off of the sensor. It then interpolates the color,
a process called demosaicing. Next, it must make some adjustments to the color of
the image to correct it for the specific color of the filters on the sensor, and then it
applies your white balance setting. After that, it applies any contrast, saturation, tone
or sharpening settings that you’ve specified in the camera, and then it converts the
image to the JPEG format—using compression algorithms to save space—and stores it.
As you can see, there’s a lot of processing that goes on in a very short amount of
time onboard the computer inside your camera, and all of this is required to turn the
captured data into a finished image.
When you shoot in RAW mode, however, the process is much simpler: the camera
reads the data off of the sensor, and writes it to the memory card. That’s it. No color interpolation, no image processing, nothing. All of that happens later in your computer,
using special software, and therein lies the advantage of shooting RAW.
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While your camera can produce a
great-looking sky saved as a JPEG file,
once you start editing that image, the
JPEG format’s lower bit depth means
you’ll more quickly run into banding
and stair-stepping than you will when
dealing with RAW files.
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What RAW won’t do
There are many advantages to shooting RAW and they’re all related to the fact that
when working with RAW, all of that processing that normally happens in the camera
(when you shoot JPEG) happens in your computer, under your control, using software
of your choosing. Whether you need this control depends on the type of editing you
do. However, it’s important to understand what RAW is not.
Shooting in RAW will not get you better detail or sharpness, nor will it get you more
colors than what you’ll get shooting JPEG. If you shoot the same scene twice, save one as
RAW and the other as JPEG, and simply print them both out without any editing, you’ll be
hard-pressed to see any difference at all. What RAW gets you is more editing power, and
the ability to preserve image quality as you edit your photos.
RAW-only Edits
There are two types of edits that you can make to a RAW file that you can’t make to a JPEG
file. The first is white balance correction. White balance is the process of calibrating your
camera to the type of light that you’re shooting in, so that colors appear accurate. This
calibration process is simply a mathematical function that’s applied to your image data.
As you saw earlier, when you shoot in JPEG mode, the adjustment is applied in the camera.
Because no white balance adjustment is applied to a RAW file by the camera, you
can adjust white balance later, while editing. This gives you a level of color correction
and adjustment that simply doesn’t exist when editing JPEG files.
The other great editing advantage of RAW files is the ability to recover overexposed
highlights. With JPEG, if you overexpose part of an image it “blows out” to complete
white. No matter how you adjust the image, there’s simply no way to recover the data
in those overblown areas.
However, when you overexpose an image, you’re don’t always overexpose all three
color channels. Sometimes when you overexpose, you only overexpose one or two

for more digital photography techniques, visit
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of the channels—say the red and the green. In these instances, your RAW conversion
software can use the surviving channels to reconstruct the overexposed channel,
allowing you to restore detail to areas that initially appear completely overexposed.
(See the images on Page 10 to get an idea of what I’m talking about.)
While this might seem unbelievable, it’s quite real. The ability to recover clipped
highlights is such a powerful feature, and it’s one of the best reasons to shoot RAW.
RAW GIVES you More to work with
Your camera probably captures 10 to 12 bits of information per pixel. If you have
a newer camera, it might even capture as much as 14 bits per pixel. “Bits per pixel”
simply means that there are more possible colors that a given pixel can be.
Unfortunately, JPEG files can only store 8 bits per pixel. This means that when
you shoot in JPEG format, your camera has to throw out a lot of color information.
This doesn’t mean that the camera has a narrower range of colors, just that it doesn’t
have as many intermediate tones to work with. With fewer tones, you’ll be less
capable of preserving smooth gradients when you’re editing.
Skies, for example, are very dependent on smooth gradients to look realistic.
While a JPEG file can produce a great-looking sky, once you start editing that sky,
the JPEG file’s lower bit depth means you’ll more quickly run into banding and
stair-stepping. (See the photo on Page 12 for an illustration of this problem.)
So, if you tend to edit a lot, and want the capability to make more extreme edits
along the way—by bringing out detail in the shadows, for example—then RAW will
give you much more editing “latitude.”
There’s No Compression with raw
JPEG files are compressed so that they don’t take up as much space on your camera’s
memory card. This is the format’s biggest strength, letting you store lots of images
in a small space. However, JPEG uses a compression process known as lossy, which
means that, when your image is decompressed (which happens when you open it
in Elements, for example), not all the original image data is present.
While this compression may not be visible straight out of the camera, if you
take a JPEG image and re-save it a few times (as a JPEG) you can quickly get visible
artifacts. RAW files have no compression applied, so you can preserve a completely
uncompressed image throughout your workflow. (If you choose to shoot in JPEG, you
should make sure you save any file you’re working on in Elements’ PSD format or the
TIF format, which don’t use lossy compression methods.)

Ben Long is a photographer, freelance writer and trainer based in San Francisco. He is the author of Complete Digital Photography (Charles River Media) and Getting Started With Camera RAW (Peachpit Press).
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What’s next?
While “shooting RAW” might seem intimidating, it really isn’t, and, if you are the
type of photographer who likes to edit your images to perfection, then RAW is the
way to go. And even if you think you’re a simple snapshot kind of shooter, capturing
RAW can save your images when the conditions aren’t perfect—you don’t have to
use all of RAW’s power to edit every picture you take.
In the next issue, we’ll look at getting started with editing RAW images, and we’ll
offer some techniques for getting the most out of your RAW images. ■
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capturing the magic of light

All images © laurie excell

LIGHT IS the key to Photography, and understanding its power can make us better photographers. In this
article, Laurie offers an inspirational look at the different types of light you can find through the day.

Lightning Oxbow Bend Grand Tetons
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P

hotographers are seekers of light. We leave our warm,
cozy beds at the crack of dawn to go in search of the
warm glow of that first light kissing the landscape. We
find ourselves the last to pack up after photographing
the golden rays of sunset, staying out long after regular folks
have gone home for dinner. We are out in the worst weather
conditions because we know that some of the best light happens
just before or after a storm. And it all comes down to light.
Light has quality and quantity; it has direction. There is the
warm glow you find from early morning or late evening hours,
or the cool tones of an overcast or shady day. The light that casts
long, deep shadows. And, whether it is flat light, back light, side
light, overcast light or daylight, we seek it out. We fill our compact
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people, birds and mammals. Under these conditions, the sky
becomes a big softbox spreading a soft light across the landscape, diffusing harsh shadows and revealing details.
If you’re willing to brave the elements on a stormy December
day on the Oregon coast, you may be rewarded with crashing
waves against the sea stacks. When the image below was taken,
there was torrential rain and winds strong enough to nearly
knock me to the ground, but I simply covered my camera with a
Shutter Hat and braced myself against the wind.

adobe photoshop elements techniques

flash cards with the same beauty that fills our hearts to try to
capture the moment we are witnessing. This is so that we can
share our experience with others, stirring their emotions as ours
did we stirred when we clicked the shutter.
When you bought your first camera, it probably came with
the clichéd advice to “photograph one hour before and after
sunrise and again at sunset”—otherwise known as the “golden”
hours. Yes, you can use this expensive new toy for exactly four
hours per day, no more, no less. And that’s assuming there is
going to be a sunrise or sunset. On overcast days, should you
go ahead and stay snuggled up in bed while images of amazing
photographs dance in your head? I think not.
There’s no denying the beauty of first light as the sun crests
the horizon, bathing the world in a warm glow (as seen in the
photo of the lighthouse above). However, if I only shot when
I found that light, I might get to shoot a total of 45 days in
a good year, living in the Pacific Northwest like I do. I have
learned to embrace those overcast days for the quality of light
they provide for a number of subjects. Those days can be
great for shooting waterfalls, flowers (like the calla lily below),
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Side light—shown in the shot below of the American
Alligator—gives our subject shape and texture, hiding as much
as it reveals. There is drama to side lighting, where long shadows
contrast with highlights, and add an aura of mystery to our
images. I typically dial in minus compensation in these situations
to increase contrast for even more impact.

f o r m o r e o n d i g i t a l p h o t o g r a p h y, v i s i t
w w w. p h o t o s h o p e l e m e n t s u s e r. c o m

When mid-morning light enters through a doorway
and bounces off the walls of an abandoned old building, it
reflects light into the nooks and crannies, creating a glowing
quality that reveals a hint of the beauty and grace of times
long gone.It was light that drew me to the window, but
looking in I foundthe green door bathed in that beautiful
light that was the real scene for me.

Backlight hides our subjects beneath a cloak of black, their
shape a silhouette against the late afternoon background. Backlight reveals what we may not notice in overcast light: the guard
hairs and beard of a grizzly rim, lighting his undeniable shape.
Once I’m sure I’ve got the composition, I dial in minus exposure
compensation to increase the drama of a backlit scene.

Moisture, in combination with the right angle of light, will
produce wonderful shafts of light—“godbeams” if you will—of
the sun streaking through the fog, spotlighting the forest’s beauty.

A clearing snowstorm throws the world into a monochromatic wonderland that just screams out for black and white
photography. Don’t sit out the storm in your warm hotel room:
jump feet first into the fray and capture the calm, quiet solitude
of an untracked snow scene, with the sky dark and overcast.
Toughing out the storm reaps rewards that might otherwise be
mere memories. A few minutes after capturing the quietude of

adobe photoshop elements techniques
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the snowy scene, its tranquility was disrupted with the lingering
noise created by many footprints running carefree through the
snow. There is never another right now, so capture the moment
as it unfolds in front of you and your camera.
At the end of the day, as the sun begins its decent towards
night, a shadow creeps up the sheer rock wall cloaking it in
darkness, the last rays of golden light bounce across the canyon
to brush across Horsetails Falls in Yosemite National Park,
creating a “firefall” of beauty that only nature can produce
when all the conditions are perfect.

As the last light of the day fades from the sky other, manmade
lights begin to come on, lighting the Golden Gate Bridge, its
warm red colors contrasting beautifully against the deep blue
of a twilight sky.
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Light truly is the primary subject in our images. Finding
interesting things for the light to drape across is what drives us in
our quest. Whether it’s that golden light of sunrise or sunset, the
overcast of a Pacific Northwest day, strong shadows of a sidelit
landscape or the dramatic light of an approaching storm, we
are photographers, seekers of light! Go out and search for your
perfect light whenever you can. ■
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Laurie leads wildlife photography safaris in North America and is an instructor with the Digital Landscape Workshop Series, Photoshop World, and Cruising
Through Life training extravaganzas. She is also the Photo Equipment Advice Desk Guru for NAPP. Check out her website, www.laurieexcell.com.
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ONE OF THE KEYs to A great PORTRAIT IS THE EYES, which are often described as THE WINDOWS TO THE SOUL.
If that truly is the case, then IT’S OUR JOB TO MAKE THOSE WINDOWS CRYSTAL CLEAR AND SPARKLING. LET’S SEE HOW.

©syndee holt

I spent many years working in commercial color labs as a print retoucher. One of the advantages of having retouched so many
hardcopy portraits is that I have been able to translate many of the retouching rules and tricks to the digital darkroom. Here are
a few of my top “eye tricks” to create expressive eyes with a little extra dimension; ones that draw you into a portrait. To make the
lesson more challenging, we are going to work on children’s eyes. We’ll start with Dominick, the grandson of my good friend Julie.

Before

After
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STEP ONE: Open your file and hold down Ctrl (Mac: Command)
and hit the ‘+’ key to enlarge the image so that the eyes are front
and center. This will make working on the details much easier.
For the lines and darkened areas of flesh under the eyes, we’ll
use the Clone Stamp tool (S) with a soft brush. In the Options bar at
the top of the screen, set the Opacity between 25% and 34%, and
choose the Stipple Dense 21-pixel brush from the Brush Presets.
Make the clone tool sample from the skin directly below the eye
area by holding down the Alt (Mac: Option) key. Then, sweep the
brush slowly underneath the eye, starting at the bottom of the eye
area and moving up to under the lashes. This will soften the wrinkles,
and lighten the area under the eye, but it won’t make it look plastic.
You do not want to completely remove the shadow area, or
you will flatten the face unnaturally (take a look at any fashion
magazine cover to see what I mean) You also do not want to
completely remove any lines or wrinkles around the eyes, as
these are “character” for the portrait. Soften them, but don’t
remove them. The exception to this is any vertical lines on the
forehead between the eyes—these lines are an indicator of stress
and should be completely removed.
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STEP TWO: Now we are going to use one of my favorite tools, the
Brush tool (B). Set the Brush Mode from Normal to Soft Light.
Set the Opacity at 14%, and Black as your foreground color
(if you have changed the default foreground and background
colors, press D to select the default of black and white). Select
a brush size just about the diameter of the bottom lashes and
sweep it across the bottom eye lashes, and then down each
individual clump of lashes.
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STEP THREE: Next, we need to get rid of the catchlights—those
bright spots of light “caught” in the eyes—at the center of the
pupil. This is the most common place you’ll see catchlights when
you use a flash, but it can cause a distracting, staring effect. Use
the Ctrl-+ (Mac: Command-+) shortcut to enlarge your image
to include only the right eye. Select your Clone tool and a
brush size that fits just in the black area of the pupil below the
catchlight. Once again, hold down the Alt (Mac: Option) key to
sample the black area and then carefully move up through the
pupil cloning this area in single clicks. Do not sweep.
Once you have the pupil complete, you should also
remove the soft reflection to the left of the pupil, and the
highlight area at the bottom of the eye. As before, don’t stroke
the area when you’re cloning; make a series of clicks with the
tool to complete this clean-up. (Remember the location of
that reflection near the pupil—we’ll re-add the catchlights
there in Step Five.)
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STEP FOUR: The reason I don’t just paint the pupil black is
that pupils are not opaque, and you will lose a little of the
“window to the soul” effect if you block it completely. I do
often darken the pupil after I’ve cleaned it up, however.
Select the Brush tool and position the brush over the
pupil and adjust the size so that it fits the pupil. Set the
Brush Mode to Soft Light, the Opacity to 14%, and make
sure that Black is the foreground color. Then click two to
three times to darken the pupil area slightly. This step may
not be necessary on eyes of lighter color, but is almost
always necessary on dark brown eyes.

for more digital editing techniques, visit
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STEP FIVE: We will now add the catchlights back, but in
a better place. Moving catchlights isn’t hard once you get
the hang of it, but you must make sure that you put the
catchlight in the corner of the eye nearest the light source.
Remember those reflections we cloned out of the left side of
the iris? This is a telltale hint about the direction of the light
source. So, let’s go back to that area and start with the Brush
tool, set to a size of 10, and the Mode to Soft Light. Then,
press the X key to toggle the foreground color to White.
Click the brush about seven times to add a white circle to
the iris. Now click the right bracket (‘[’) key to make your brush
one size larger and then click about four more times.
Notice how this gives the catchlight a soft, rounded look?
This helps sculpt that flat eye into a rounded, dimensional
image. The rule for sizing the catchlights is the further away
the light source, the smaller the catchlight. This image was
taken outdoors, so I want a smaller size for my catchlight.
To complete the catchlight replacement, we’ll add a reflection in the iris directly opposite the catchlight corresponding
to the angle of the light. Use the same tool setup as for the
catchlight, but set the brush size on 10. Stroke lightly between
the darker lines of the iris, at approximately the 4 o’clock position, with smaller length strokes at each end of the reflection.
This is a subtle step, so don’t go overboard here.
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STEP SIX: Now, we’ll lighten the whites of the eyes. We’ll use
a soft triangular area to accomplish this, to help erase signs
of aging and redness. It will even make the eye look larger!
In the shot below, I have drawn the approximate area and
shape we will work on.
Select your brush with the Mode set on Soft Light and the
Opacity set at 14%, and make sure your foreground color is
white. Brush in that triangular area. This time you can use
sweeping strokes in the area. I try to have the top portion of
the a little lighter than the bottom portion. Because Dom has
slightly redder eyes, I’ll even do a quick sweep outside the triangle area right along the lids. Repeat this on the inner corner
of the eye also.
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STEP SEVEN: Next, we’ll work a bit more on the iris. Select the
Eye Dropper (I) and click in the golden portion of his irises
next to the pupil. This will make that color the new foreground
color. Then, switch back to the Brush tool, using the same settings you used in the last step. Brush lightly in and around the
bottom part of the iris to enhance its color slightly.
Then, set your foreground and background colors back to
default by pressing D. Keeping the same settings, use the brush
and stroke a line around the outside edge of the iris to help
define it. Dom already has a naturally dark area there, but we
can help define it a little more with a couple strokes of black.
Hold down the Ctrl (Mac: Command) key and the minus
key (‘-‘) to zoom back out and admire the results compared to
the unretouched eye. Take a look at the image of both eyes
(shown on the left) . See how the right eye now looks more
round and dimensional?
Now comes the hard part: You still have one more eye to
work on! So, repeat Steps Three through Seven on the left eye.
Periodically, you might want to zoom out to make sure that
you are balancing the work on the two eyes.
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STEP EIGHT: Before we complete our work on the eyes, let’s
try one more retoucher’s trick, this time on the teeth. Click
on your brush tool, then click on the foreground color at
the bottom of the Tool palette (to bring up the Color Picker
dialog box) and select a light lavender color. If you want to
use the same color I used here, type f0ccf7 in the ‘#’ field of
the dialog box.
With the brush on Soft Light mode and at an Opacity of
16%, lightly brush each individual tooth with the lavender.
This will both lighten the teeth and diminish any yellow discolorations. That’s right, for whiter teeth, use lavender, not white:
it gives the teeth a more realistic look.
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for more digital editing techniques, visit
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STEP NINE: Next, we’ll “burn in” the edges of the photo to
put more focus on the face—and our retouched eyes. Press D
to reset the foreground color to black and increase the brush
size considerably (you might also want to use a softer brush,
depending upon your image). Sweep around the corners of the
image to “burn” in the edges slightly. Here, I’m paying special
attention to the top of Dom’s hand and diverting around the
shadow area of the hand. You can even use this technique to
soften things like the highlight on the tip of his nose.

STEP TEN: Now we’ll have some layer fun. Make two duplicate
layers by selecting Layer > Duplicate Layer twice. Name the
new layers Layer 1 and Layer 2.
Click on Layer 1, the middle layer, on the Layer palette to
select it. Go to Filter > Blur > Gaussian Blur and type 33.5 into
the Radius selection. This will really blur the layer.
Hide Layer 2 by clicking on the eye to the left of the layer
name on the Layers palette.

EXTRAS

Go to the Subscriber area at photoshopelementsuser.com for a second “Eyes have it” tutorial from Syndee.

Syndee Holt is an independent designer for Jacquard Products, Polyform Products, and Savage Universal. Her work can be found in many arts and craft magazines,
as well as on numerous television shows. Check her out on the Web at www.synspage.com.
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STEP eleven: Click on Layer 1 and choose the Eraser tool (E).
Set the Eraser’s opacity to about 53%. Select the Stipple Dense
brush again and enlarge it to about 70 pixels. Carefully erase the
blur in the eye areas with the tool.
Turn Layer 2 back on and then select it. Reduce the layer’s
Opacity slowly to select the amount of “glow” you want for
the skin. As you reduce the opacity, the skin softens, but the
eyes soften at a much slower rate because we erased much of
the softness from the blurred layer. I set it here at about 60%,
but the amount will vary with the look you want.
If you compare the before and after versions of Dom (on
Page 19), you can see just how much those amazing eyes
capture you—all with only a little bit of detail work! ■
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Customizing the
Info palette ▼
Did you know you can customize the
information that’s displayed in the Info
palette (Window > Info)? Just select the
palette’s More menu (in the upper right
corner) and choose Palette Options. In
this dialog box you can determine what
information you want the Info palette
to display. The most useful items you
can change are the ruler units, which
by default is set to inches, but if you’re
working on an image for the Web, you

T i p s

might prefer to see the possible crop
information in pixels (as in the image
on the left). You can also add lines to
the palette that include the current
file’s dimensions, size, and color profile.
Some of the other options—Efficiency,
Scratch Sizes and Timing—can be helpful
if you’re trying to troubleshoot performance issues with your computer, but
they aren’t necessary for everyday work.

Keyboard shortcuts for
making quick fills
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Easier alignment when
dragging layers between
two different files
If you’re dragging layers between two
open documents in Elements, you
may find that it’s difficult to determine
where the layer will be placed in the
window that you are dragging it to.

All images by Matt Kloskowski unless otherwise noted
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If you’ve been using Elements for a
while, you know there are a ton of
keyboard shortcuts designed to help
you get things done faster. Most of
them can be found next to the menu
item that they ’re applicable to, but
there are a few really useful ones that
you won’t find easily. For example,
we’re constantly filling selections and
layers with colors: Instead of using the
Paint Bucket tool, you can quickly fill a
layer or selection with the Foreground
color by pressing Alt-Backspace (Mac:
Option-Backspace). If you want to fill
something with the current Background
color, press Ctrl-Backspace (Mac:
Command-Backspace).

for more tips and tricks, visit
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To get around this, hold down the
Shift key when dragging the layer, and
Elements will automatically place the
contents of the layer in the center of
the document when you release the
mouse button.

Saving a mouse click
during filter previews
Many of Elements’ filters let you preview
the effect while you have the dialog box
on-screen, so you can see the before and
after view of your image. While you can
click the Preview check box with your
mouse, you can also press the P key to
turn it on and off.

You can increase or decrease the hardness of your current brush—without
changing its size—directly from the
keyboard. Press Shift-] (Right Bracket)
to increase the hardness (or decrease
the softness) of the current brush, and
Shift-[ (Left Bracket) to decrease the
hardness of the brush.

Elements Arrow tool
A lot of folks don’t know that there’s a
built-in arrow tool in Elements, most likely
because it’s not actually called the Arrow
tool. Here’s how to draw one:
Select the Line tool, but before you use
it, look in the Options Bar at the top of the
screen and click on the Geometry Options
menu (at the end of the shape icons). There,
you’ll see options for creating and adjusting
arrowheads at both ends of the line (see
above right). The Width option goes from
10% to 1000%, while Length goes from 10%
to 5000%, where the percentage is related
to the thickness of the line. The Concavity
option goes from -50% to 50% and sets the
curvature of the widest part of
the arrowhead. Then choose the
weight of the line in the Options
Bar and click-and-drag with the
Line tool to create your arrow.
There is one drawback: you
cannot adjust the arrowhead
after the line has been drawn.
You must change the settings in
the Options Bar and redraw the
line. The image above shows an
example of the types of arrows
that can be created.

Geometry Options for
other shape tools ▼
There are Geometry Options also available
with the other shape tools. Click on the
Rectangle tool, Rounded Rectangle tool,
or Ellipse tool and the options include
setting the shape to a Fixed Size or making it Proportional (using a ratio—like
1:1—instead of specific measurements),
and drawing from the center outwards.
Switch to the Polygon tool and you’ll
get options that include Radius, Smooth
Corners, or the ability to create a star. ■

adobe photoshop elements techniques

Setting brush hardness
via the keyboard

▲ Using the ultra-secret
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get a little glow on
THERE’S SOMETHING ALMOST MAGICAL ABOUT LIGHT. IT ATTRACTS OUR EYE, DRAWS US IN, AND HEIGHTENS OUR SENSE OF WONDER.
ADDING A SIMPLE GLOW TO YOUR PHOTOS CAN CREATE THIS MAGICAL, MYSTERIOUS QUALITY AND CAPTURE THE IMAGINATION.

STEP ONE: Our first challenge is to get
anything that will be in front of or not
illuminated by our glowing light on its
own layer. In our example, this will be the
small chest and a portion of the boy’s arm.
Using your preferred selection tools and
methods, make your selection and press
Ctrl-J (Mac: Command-J) to put the
selection on its own layer.

adobe photoshop elements techniques
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TIP: If you need a refresher on making
selections, go to the Video Tips section of
the Photoshop Elements Techniques Web
site and search for “selections.”
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STEP TWO: Make a new layer and draw an
oval selection with the Elliptical Marquee
tool (M) that extends a bit beyond the
edges of the chest. This will be the “throw
area” of the glowing light. Click on the
Foreground color square in the Color
Picker and select a color for your mysterious “glow.” (We used R 255 G 252 B 148.)
Making sure the new layer is selected, press
Alt-Backspace (Mac: Option-Delete) to fill
the selection with the color. Then deselect
by pressing Ctrl-D (Mac: Command-D).

for more digital editing techniques, visit
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STEP THREE: Before going further, let’s
rename the layers (by double-clicking
on the layer). Starting at the top, ours are
Glow-Box, Chest, and Background. Now
we’ll add the glowing effect. Click on
the Glow-Box layer, go to Filter > Blur >
Gaussian Blur, and add a fairly high blur to
the layer, to create a nice, diffused glow.
The radius amount will need to be larger
for high-resolution images. Experiment
with the amount until you achieve the
desired effect. In our example, we used
a radius setting of 55.

STEP FOUR: Now we’ll fine-tune the
location of the glow. Press Ctrl-T (Mac:
Command-T) to bring up Free Transform.
Using the handles on the bounding box,
resize, rotate, and position the glow to
create the desired throw of light. Press
Enter (Mac: Return) when you’re finished.
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STEP FIVE: The boy will also be affected by
the light, so select the Glow-Box layer and
duplicate it by going to Layer > Duplicate
Layer. On the Layers palette, double-click
the name of this new layer and change it to
Glow-Face. Switch to the Move tool (V) and
position the duplicated glow around his face
and shoulders. Like you did with the first
glow layer, use Free Transform to position
and resize the area of the glow. Then, lower
the layer’s opacity to lessen the intensity of
the light on his face (we used 65%).
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STEP SIX: Move over to the Layers
palette, target the Chest layer, and drag it
above the two glow layers. If either glow
is too intense, you can select the layer
and lower its opacity until you’re happy
with the effect.
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STEP SEVEN: To heighten the sense of
mystery, let’s darken the image. Hide the
Chest and two Glow layers by clicking on
the eye icon for each layer. Then click on
the Background layer to select it. Click the
Create Adjustment Layer icon at the top
of the Layers palette, and choose Levels.
Making sure the Preview box is checked,
drag the black input slider to the right to
darken the image.
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STEP EIGHT: When you’re happy with
the look, click OK, and drag that Levels
adjustment layer to the top of the Layers
stack. Make the other layers visible again
(by clicking on the eye icon), and you’re
ready for the final step.

STEP NINE: Let’s use the adjustment
layer’s mask to paint back some light.
Select the Brush tool (B) and choose a
soft, round, medium-sized brush. In the
options bar, lower the Brush Opacity (we
started with 50%), and, with black set
as your foreground color, click the layer
mask on the adjustment layer and paint
black on the areas that should be brighter
(to hide the darkening effect). Continue
to lower the Brush Opacity as you move
further from the light’s epicenter. If you
need to bring back some of the darkening
effects, switch your foreground color to
white and paint on the mask. When you’re
happy with the look, put your brush
down. Your ethereal glow is complete,
and, completely editable! ■
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With a Master’s degree in Educational Technology and 16 years of teaching experience, Mike Rodriguez currently teaches classes in Adobe Photoshop Elements,
Paint Shop Pro, and other computer applications. He also contributes Photoshop CS3 video tutorials to layersmagazine.com and videos on Photoshop Elements
to photoshopelementsuser.com.

29

Scrapbookers’ Workshop
B Y

N A N C Y

©ISTOCKPHOTO/Andrew Penner

Step by Step

M A R T I

tag, you’re it!
TAGS ARE A GREAT WAY TO EMBELLISH YOUR SCRAPBOOK LAYOUTS. THEY OFFER FUN AND SIMPLE WAYS TO SAY SOMETHING
WITHOUT A LOT OF THE SAPPY JOURNALING THAT MANY PEOPLE CITE AS A TURN-OFF TO SCRAPBOOKING. THE EXAMPLES
SHOWN HERE ARE JUST A FEW OF THE WAYS YOU CAN ADD a little more POP TO YOUR pages.

All tags and elements from kits by Nancy Marti

The Tag Frame
This frame is a lovely way to add a smaller photo to enhance the main photo that is
the focus of your page. You can add text or elements to the frame to dress it up or
just keep it simple. Your photos will need to be resized and cropped to fit a smaller
frame, but this is a great way to combine your favorite images. Tack them along the
edge of the frame on a larger photo or hang them along a wire or ribbon.
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The tag is one of
the most versatile
elements in
scrapbook layouts.
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The Layered Tag
Tags turn into miniature collages simply by layering multiple items on one tag.
This gives the tag much more appeal and interest on a page. When layering items you
can add torn edges, more tags and flowers and other embellishments. Too much will
cause chaos and clutter, though, so try to keep your designs simple.

for more digital scrapbook techniques, visit
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The Word Art Tag
This type of tag can be used to say just want you want and
nothing more. It is simple, effective and very eye-catching.
You can make your word art simple or full of flourish, but
always keep in mind the size of your tag and the ability to
read the wording on a finished project.

The Element Tag
Often you can use an element from a scrapbook kit to create
a tag. Tags of this nature generally do not include word art as it
tends to get lost in the image. This type of tag adds dimension
and interest to a layout and allows the use of elements in a more
creative way. In this instance a lace heart was turned into a tag
by cutting a hole in the heart and intertwining it with another
element to create a tag hanger.

The Tag Collage
This is a collection of tags
all tied together in a single
theme. You can use them to
display alphas (standalone
letters and numbers) or to
create word art. Try creating
a collage and saving it as a
“garden” of tags to drop onto a
page and have a very impressive page with little effort. You
can reuse it over and over, and
the hard work on the page is
already done. Just add a photo
and your own text.

The Tag Alpha
This example shows how you can use tags to display your alphas
with a little more pizzazz. You can include other page elements
or just keep it simple. Try tying them together—as I’ve shown
here—or string them along a ribbon or wire.
Either way, they give the page a more
professional look.

EXTRAS

Visit the forums at DigitalDesignDen.com to learn how to make a version of the photo tag and the layered collage tag.
The site also has lots of other tutorials on making scrapbook items.

Nancy Marti is a designer at www.digitaldesignden.com. She serves as a forum moderator at ElementsVillage.com and works full-time for a legal consulting firm.
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No matter how you use it, the tag is
one of the most versatile elements
in scrapbook layouts. There are
no rules, no special techniques,
no right or wrong. There is just
your imagination and creativity.
Experiment with your own ideas
and be sure to add some layouts to the
gallery at elementsvillage.com, so everyone
can see your creative ideas! ■
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Why do I sometimes get a little yellow triangle
in the top right corner of the Histogram
palette—and what does it mean?
That icon means the histogram is not reflecting the latest change
(i.e. adjustment) made to the image. To update the Histogram palette
(found under Window > Histogram), simply click on the yellow
triangle or the blue refresh symbol just above the triangle, and the
histogram will redraw to reflect the changes made to the image.
If this becomes a bit tedious, there is a way to have the histogram
more accurately reflect these changes without you having to refresh
it every time you make an alteration. Go to Edit > Preferences (Mac:
Photoshop Elements > Preferences) and choose Performance from
the list on the left side of the dialog. You should see something called
Cache Level under the History & Cache section on the right side of
the dialog. Lowering this number will cause Elements to draw an
accurate Histogram as changes are made. In most cases, though, your
system won’t be noticeably slower. If it is—if you don’t have enough
RAM, or you tend to work with lots of large-size images—you might
want to play around with the setting to get the best combination of
performance and efficiency.

I recently processed some JPEG images for
posting on my Web site. When I looked at the
images, I noticed that some of the camera
information was missing. How come?
My guess is that you used the Save for Web under
the File menu to make your JPEG. One feature of Save for Web
is that it strips the metadata—that extra “stuff ” that gets stored
with a photo, like camera name, shutter speed, aperture setting,
captions, keywords and more—out of an image. If you want to
keep that information, use the Save As… command from the
File menu. In that dialog box, select JPEG (not JPEG 2000) from
the Format pop-up, which is right below the File Name field.
When you click Save, you’ll get a new dialog box allowing you
to choose a quality setting between 0 and 12, with 0 being a
small-size file, and 12 being a larger file, but with the highest
possible quality. Make your choices and click OK. This JPEG
file should now include all of the metadata that was previously
associated with the image.

If you have a Photoshop Elements question you’d like to see answered, send it to q&a@photoshopelementsuser.com.
If your question just can’t wait, visit our Photoshop Elements forum at www.photoshopelementsuser.com/forum to
get answers from other members. (But still feel free to send your question along for us to publish.)

Subscribe Today to the
Ultimate “How-To” Guide!
Photoshop Elements Techniques is the combination
newsletter and Web site that teaches you how to use all
of the fantastic features of Adobe’s photo-editing software.
Let leading Photoshop Elements gurus show you how to:
■■

Enhance, correct and restore your photos.

■■

Create amazing special effects

■■

Print, share and organize your photo collection

■■

Design beautiful scrapbooks, greeting cards and more

■■

Get the most out of your digital camera or scanner
to create images that pop off your screen

FREE WITH YOUR SUBSCRIPTION
Printed Newsletter: A 32- to 40-page newsletter—packed with
easy-to-follow tutorials, in-depth features and loads of tips and
tricks—delivered to your home six times a year.
Exclusive Online Content: All access to more than 400 video
and written tutorials in our exclusive subscriber-only area. You’ll find
tips and tricks that will help you fix underexposed or overexposed
images, create cool special effects, add embellishments for digital
scrapbooking and more! Download the same files the experts use
in their tutorials so you can follow along with every issue.
Internet Forum and Gallery: Connect with other Photoshop
Elements users in our online forums. Ask questions, share ideas and
show off your work in our subscriber Image Gallery.
Contests, Challenges and Giveaways: Submit your work to
our subscriber gallery and qualify for weekly giveaways.

Don’t delay—sign up today, at:
www.photoshopelementsuser.com/subscribe

FREE “BEST OF” DVD!
And, if you act now, you’ll receive “The Best of Photoshop Elements Techniques,
Vol. 2” DVD, which includes nearly 30 how-to videos and searchable PDFs of
every issue published in 2007. This $40 value is yours FREE with any subscription
to Photoshop Elements Techniques newsletter. Just enter the Promo Code
“PDF-08” code when subscribing, and we’ll take care of the rest.

